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Product Summary

This release bulletin discusses known issues, workarounds, and late-breaking documentation
updates for Sybase® Mobile SDK version 2.1 ESD #2.

This release is targeted toward mobile application developers. For information about new
features in this version, see New Features for Sybase Mobile SDK and Runtime 2.1 ESD
#2.

For installation information, see Installation Guide for Sybase Mobile SDK 2.1 and the EBF
README included with the 2.1 ESD #2 product download.

For information about accessibility, see http://www.sybase.com/products/accessibility.

Upgrading and Migrating

Learn about options available in the upgrade.

You can upgrade Unwired Platform version 2.1 ESD #2 from version 2.1 and 2.1 ESD #1. You
can migrate MBO projects and workflows from previous versions. Although minor point
releases of Unwired Platform generally support upgrading only from the last major point
release, Sybase Unwired WorkSpace can migrate MBO projects and workflows from earlier
releases. See the version compatibility matrixes for details.

Native Client Object API Version Compatibility Matrix
Compatibility between versions of the Native Client Object API and Unwired Server.

Native Client Object API and Unwired Server Version Compatibility

Native
Client
Object
API

Unwired
Server
1.2

Unwired
Server
1.5.x

Unwired
Server
2.0.x

Unwired
Server 2.1

Unwired
Server 2.1
ESD #1

Unwired
Server
2.1 ESD
#2

Native Cli-
ent Object
API 1.2

Yes No No No No No

Native Cli-
ent Object
API 1.5.x

No Yes Yes Yes Yes Yes
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Native
Client
Object
API

Unwired
Server
1.2

Unwired
Server
1.5.x

Unwired
Server
2.0.x

Unwired
Server 2.1

Unwired
Server 2.1
ESD #1

Unwired
Server
2.1 ESD
#2

Native Cli-
ent Object
API 2.0.x

No No Yes Yes Yes Yes

Native Cli-
ent Object
API 2.1

No No No Yes Yes Yes

Native Cli-
ent Object
API 2.1
ESD #1

No No No No Yes Yes

Native Cli-
ent Object
API 2.1
ESD #2

No No No No No Yes

Migrating Object API Applications
Make required changes to an application to use the new APIs introduced in SDK version 2.1
ESD #2. You can migrate client applications built from the previous SDK versions 2.0, 2.0
ESD #1, 2.1, or 2.1 ESD #1.

When an existing client application built from a previous SDK version is integrated with the
2.1 ESD #2 SDK and installed on a device it must be fully functional, with its related server
packages deployed prior to performing an upgrade, or deploying a new server package after an
upgrade.

Android
No application or project changes are required.

No additional changes were introduced in SDK version 2.1 ESD #2.

BlackBerry
Changes required for BlackBerry applications.

Application Changes Introduced in 2.1 ESD #2
Update and rebuild your application:
1. The Application APIs (in the Application class) are required for managing

applications registrations, connections, and context. Rewrite the initialization code in your
application to use the Application APIs.

Upgrading and Migrating
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For information on the Application interface, search for Application APIs in the
Developer Guide for your platform.

2. Callbacks related to application events are now contained in a separate
ApplicationCallback interface. Rewrite your application code to use this interface.

For information on the ApplicationCallback interface, search for Callback and
Listener APIs in the Developer Guide for your platform.

3. Replication-based synchronization clients require two data channels, a data channel for
data synchronization, and a messaging channel for sending registration and push
notifications to the client. Update your port configuration for both channels. See Sybase
Control Center for Sybase Unwired Platform > Administer > Unwired Server > Server
Properties.

4. To continue using server-initiated synchronization, you must write code for handling
notifications. If change notifications are enabled for synchronization groups, you can
implement the onSynchronize callback method to monitor this condition, and either
allow or disallow default background synchronization.
public int onSynchronize(ObjectList groups, 
SynchronizationContext context)
{
  int status = context.getStatus();
  if (status == SynchronizationStatus.STARTING_ON_NOTIFICATION)
  {
    // There is changes on the synchronization group
    if (busy)
    {
      return SynchronizationAction.CANCEL;
    }
    else
    {
      return SynchronizationAction.CONTINUE;
    }
  }

  // return CONTINUE for all other status
  return SynchronizationAction.CONTINUE;
}

5. The new location of the required libraries is UnwiredPlatform_InstallDir
\UnwiredPlatform\MobileSDK\ObjectAPI\BB.

Rebuild your project as follows:
a. Modify the BlackBerry project's Java build path to point to the new location for your

project.
b. Replace the old libraries, sup_client_rim.jar and UltraLiteJ.jar, with the following new

references:
• sup_client2.jar – from UnwiredPlatform_InstallDir\MobileSDK

\ObjectAPI\BB.

• UltraLiteJ1.jar – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\BB.

Upgrading and Migrating
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c. In Windows Explorer, copy the new required files into the BlackBerry simulator
directory:
• CommonClientLib.cod – from UnwiredPlatform_InstallDir

\MobileSDK\ObjectAPI\BB.

• MessagingClientLib.cod – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\BB.

• MocaClientLib.cod.cod – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\BB.

• sup_client2.cod.cod – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\BB.

• UltraLiteJ12.cod – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\BB.

d. Delete the old CommonClient.cod, sup_client_rim.cod, and UltraLiteJ.cod files.

iOS
Changes required for iOS applications.

Application Changes Introduced in 2.1 ESD #2
Update and rebuild your application:

1. The Application APIs (in the SUPApplication class) are required for managing
applications registrations, connections, and context. Rewrite the initialization code in your
application to use the Application APIs. Replace references in your application to the
Messaging Client API (SUPMessage class) with the appropriate use of the Application
APIs (SUPApplication).

For information on the SUPApplication interface, search for Application APIs in the
Developer Guide for your platform.

2. Callbacks related to application events are now contained in a separate
ApplicationCallback interface. Rewrite your application code to use this interface.

For information on the ApplicationCallback interface, search for Callback and
Listener APIs in the Developer Guide for your platform.

3. Replication-based synchronization clients require two data channels, a data channel for
data synchronization, and a messaging channel for sending registration and push
notifications to the client. Update your port configuration for both channels. See Sybase
Control Center for Sybase Unwired Platform > Administer > Unwired Server > Server
Properties.

4. In addition to the required libraries provided in previous SDK versions (libMO.a,
libclientrt.a, and libSUPObj.a), two new libraries (libsupcore.a, libAfariaSLL.a) are
provided and are required for all iOS applications. These libraries also require additional
Apple-provided frameworks to be included when building object API applications.

Upgrading and Migrating
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For information on importing required libraries, see Developer Guide: iOS Object API
Applications 2.1 ESD #2 > Development Task Flow for Object API Applications >
Creating a Project > Importing Libraries and Code.

Windows and Windows Mobile
Changes required for Windows and Windows Mobile applications.

Application Changes Introduced in 2.1 ESD #2
Update and rebuild your application:

1. The Application APIs (in the Application class) are required for managing
applications registrations, connections, and context. Rewrite the initialization code in your
application to use the Application APIs.
For information on the Application interface, search for Application APIs in the
Developer Guide for your platform.

2. Callbacks related to application events are now contained in a separate
ApplicationCallback interface. Rewrite your application code to use this interface.

For information on the ApplicationCallback interface, search for Callback and
Listener APIs in the Developer Guide for your platform.

3. Replication-based synchronization clients require two data channels, a data channel for
data synchronization, and a messaging channel for sending registration and push
notifications to the client. Update your port configuration for both channels. See Sybase
Control Center for Sybase Unwired Platform 2.1 ESD #2 > Administer > Unwired Server
> Server Properties.

4. To continue using server-initiated synchronization, you must write code for handling
notifications. If change notifications are enabled for synchronization groups, you can
implement the onSynchronize callback method to monitor this condition, and either
allow or disallow default background synchronization.
public int OnSynchronize(GenericList<ISynchronizationGroup> 
groups, SynchronizationContext context)
{
  int status = context.Status;
  if (status == SynchronizationStatus.STARTING_ON_NOTIFICATION)
  {
    // There is changes on the synchronization group
    if (busy)
    {
      return SynchronizationAction.CANCEL;
    }
    else
    {
      return SynchronizationAction.CONTINUE;
    }
  }

  // return CONTINUE for all other status

Upgrading and Migrating
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  return SynchronizationAction.CONTINUE;
}

5. In 2.1 ESD #2, the new location of the required libraries is
UnwiredPlatform_InstallDir\UnwiredPlatform\MobileSDK
\ObjectAPI.

Rebuild your project as follows:
a. Reset the references of the following libraries for the appropriate device platform in the

Visual Studio project according to the new location:
• For Windows Mobile:

• sup-client.dll – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\WM.

• iAnywhere.Data.UltraLite.dll – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\WM\Ultralite.

• iAnywhere.Data.UltraLite.resources.dll (several languages are supported) –
from UnwiredPlatform_InstallDir\MobileSDK\ObjectAPI
\WM\Ultralite\language.

• For Windows:
• sup-client.dll – from UnwiredPlatform_InstallDir\MobileSDK

\ObjectAPI\Win32.

• iAnywhere.Data.UltraLite.dll – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\Win32\Ultralite.

• iAnywhere.Data.UltraLite.resources.dll (several languages are supported) –
from UnwiredPlatform_InstallDir\MobileSDK\ObjectAPI
\Win32\Ultralitelanguage.

b. Remove the following libraries for the appropriate device platform as items in the
Visual Studio project. The libraries are no longer required.
• For Windows Mobile:

• ulnet11.dll
• mlcrsa11.dll (if HTTPS protocol is used)
• PUtilTRU.dll

• For Windows:
• ulnet11.dll
• mlcrsa11.dll (if HTTPS protocol is used)
• mlczlib11.dll (if using compression)

c. Add the following libraries for the appropriate device platform as items in the Visual
Studio project. Set the "Build Action" to Content and "Copy to Output Directory" to
Copy always.
• For Windows Mobile:

• ulnet12.dll – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\WM\Ultralite.

Upgrading and Migrating
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• mlcrsa12.dll (if HTTPS protocol is used) – from
UnwiredPlatform_InstallDir\MobileSDK\ObjectAPI\WM
\Ultralite.

• mlczlib12.dll (if HTTPS protocol is used) – from
UnwiredPlatform_InstallDir\MobileSDK\ObjectAPI\WM
\Ultralite.

• CMessagingClient.dll – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\WM\DeviceType. The DeviceType can
be Pocket PC or Smartphone as applicable.

• For Windows:
• ulnet12.dll – from UnwiredPlatform_InstallDir\MobileSDK

\ObjectAPI\Win32\Ultralite.
• mlcrsa12.dll (if HTTPS protocol is used) – from

UnwiredPlatform_InstallDir\MobileSDK\ObjectAPI
\Win32\Ultralite.

• mlczlib12.dll (if using compression) - from
UnwiredPlatform_InstallDir\MobileSDK\ObjectAPI
\Win32\Ultralite.

• CMessagingClient.dll – from UnwiredPlatform_InstallDir
\MobileSDK\ObjectAPI\Win32.

• ECTrace.dll – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\Win32.

• TravelerLib.dll – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\Win32.

• zlib1.dll – from UnwiredPlatform_InstallDir\MobileSDK
\ObjectAPI\Win32.

Object API Changes from Version 2.1 through Version 2.1 ESD #2
Complete summary of changes in the Object API made between Unwired Platform versions
2.1 and 2.1 ESD #2.

The following topics contain a summary of all changes in the Object API. Most of these
changes add new functionality and do not affect existing applications.

Object API Changes in SDK Version 2.1 ESD #2
There are changes in the Object API in SDK 2.1 ESD #2 (the changes were introduced in SDK
2.1 ESD #1 for Android). If your application is built with an earlier version of the SDK, update
your application to include the required or recommended API changes.

Application APIs
Sybase Unwired Platform now supports and requires clients to use the Application APIs to
manage mobile application registrations, application connections, and context. These APIs
are provided in the Application (or SUPApplication) class.

Upgrading and Migrating
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Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, Developer Guide: iOS Object API Applications, and
Developer Guide: Windows and Windows Mobile Object API Applications

• Initializing an Application
• Application APIs

ApplicationCallback APIs
Sybase Unwired Platform supports a new ApplicationCallback interface that is
invoked by events of interest to a mobile application.

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, Developer Guide: iOS Object API Applications, and
Developer Guide: Windows and Windows Mobile Object API Applications

• ApplicationCallback API

Large Attribute APIs
Sybase Unwired Platform supports new large attribute APIs to allow clients to import large
messages containing binary objects (BLOBs) from the server or send a replay message
without using excessive memory or throwing exceptions.

These new classes support large attributes:

• BigBinary (or SUPBigBinary)
• BigString (or SUPBigString)

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, Developer Guide: iOS Object API Applications, and
Developer Guide: Windows and Windows Mobile Object API Applications

• Large Attribute APIs

Change Log APIs
(Not available in SDK version 2.1 ESD #2 for iOS). New change log APIs allow a client to
retrieve entity changes from the backend. If a client application already has a list view
constructed, it simply needs to add, modify, or delete entries in the list according to the change
logs.

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, and Developer Guide: Windows and Windows Mobile
Object API Applications

• Change Log API

Asynchronous Operation Replay APIs
(Not available in SDK version 2.1 ESD #2 for iOS). Asynchronous Operation Replay allows
users to submit changed data outside a synchronization session without waiting for EIS
execution. When an application calls submitPending on an MBO on which a create,

Upgrading and Migrating
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update, or delete operation is performed, an operation replay record is created on the device
local database.

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, and Developer Guide: Windows and Windows Mobile
Object API Applications

• Asynchronous Operation Replay

Encryption Key Management APIs
New methods in the connection profile support managing the encryption key for the local
client database.

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, and Developer Guide: Windows and Windows Mobile
Object API Applications

• ConnectionProfile
• Encrypt the Database

Developer Guide: iOS Object API Applications

• SUPConnectionProfile
• Encrypting the Client Database

Change Notification APIs for Push Synchronization
(Not available in SDK version 2.1 ESD #2 for iOS). Sybase Unwired Platform now supports
using a messaging channel to send change notifications from the server to the client device.
Clients receive device notifications when a data change is detected for any of the MBOs in the
synchronization group to which they are subscribed. By default, change notification is
disabled. You can enable the change notification through setting properties in the
synchronization group.

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, and Developer Guide: Windows and Windows Mobile
Object API Applications

• Push Synchronization Applications

Removed APIs
The Messaging Client APIs (SUPMessageClient interface) are removed. If your
application uses the SUPMessageClient interface, you must rewrite it to use functionality
from SUPApplication.

Upgrading and Migrating
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Object API Changes in SDK Version 2.1
There are changes in the Object API in SDK 2.1. If your application is built with an earlier
version of the SDK, update your application to include the required or recommended API
changes.

Object Query Enhancements
The Object API provides increased access to the underlying relational persistence layer. SQL
features and functions have been added to the dynamic query method, ExecuteQuery.

The additions allow you to:

• (Update) Exclude duplicate entries from result sets using the arbitrary Find method
Query.DISTINCT property.

• (Update) Define a filter condition using an MBO attribute using the new conditions, IN,
NOT_IN, EXISTS, and NOT_EXISTS. You can nest queries, as well as use LIKE
keywords in queries.

• (New) Use aggregate functions.
• (New) Group your results using specific attributes.
• (New) Specify how your results are filtered.
• (New) Combine the results of multiple queries into a single result set.
• (New) Include subqueries in SELECT statements.

Documented in Developer Guide: Android Object API Applications, Developer Guide:
BlackBerry Object API Applications, Developer Guide: iOS Object API Applications, and
Developer Guide: Windows and Windows Mobile Object API Applications

• Query API

Hybrid Web Container Version Compatibility Matrix
Compatibility between versions of the Hybrid Web Container and Unwired Server, and
Hybrid Web Container and Mobile Workflow applications.

Hybrid Web Container and Unwired Server Compatibility

Client/ Hy-
brid Web
Container

Unwired
Server 2.0

Unwired
Server
2.0.1

Unwired
Server 2.1

Unwired
Server 2.1
ESD #1

Unwired
Server 2.1
ESD #2

Pre-2.0 Client
Stack/ Appli-
cations

Yes Yes No No No
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Client/ Hy-
brid Web
Container

Unwired
Server 2.0

Unwired
Server
2.0.1

Unwired
Server 2.1

Unwired
Server 2.1
ESD #1

Unwired
Server 2.1
ESD #2

Hybrid Web
Container 2.0

Yes Yes Yes Yes Yes

Hybrid Web
Container
2.0.1

No Yes Yes Yes Yes

Hybrid Web
Container 2.1

No No Yes Yes Yes

Hybrid Web
Container 2.1
ESD #1

N/A N/A N/A N/A N/A

Hybrid Web
Container 2.1
ESD #2

No No No No Yes

Note: There was no 2.1 ESD #1 Hybrid Web Container. The 2.1 ESD #1 release shipped with
2.1 clients.

Hybrid Web Container and Mobile Workflow Application Compatibility

Client/ Hy-
brid Web
Container

Mobile
Workflow
Application
2.0

Mobile
Workflow
Application
2.0.1

Mobile
Workflow
Application
2.1

Mobile
Workflow
Application
2.1 ESD #1

Mobile
Work-
flow Ap-
plica-
tion 2.1
ESD #2

Pre-2.0 Client
stack/ Applica-
tions

Yes Yes No No No

Hybrid Web
Container 2.0

Yes No No N/A No

Hybrid Web
Container 2.0.1

Yes Yes No N/A No

Hybrid Web
Container 2.1

Yes Yes Yes N/A No
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Client/ Hy-
brid Web
Container

Mobile
Workflow
Application
2.0

Mobile
Workflow
Application
2.0.1

Mobile
Workflow
Application
2.1

Mobile
Workflow
Application
2.1 ESD #1

Mobile
Work-
flow Ap-
plica-
tion 2.1
ESD #2

Hybrid Web
Container 2.1
ESD #1

N/A N/A N/A N/A N/A

Hybrid Web
Container 2.1
ESD #2

Yes Yes Yes N/A Yes

Note: There was no 2.1 ESD #1 Hybrid Web Container. The 2.1 ESD #1 release shipped with
2.1 clients.

Migrating Mobile Workflow Projects
Mobile workflow projects work properly without special handling, unless you want to
upgrade to the new workflow client containers.

When upgrading to SDK version 2.1 ESD #2:

• To use the new 2.1 ESD #2 functionality, use the Mobile Workflow Forms Editor to
regenerate and repackage mobile workflows developed in earlier versions.

• Any customizations made in previous versions to the Custom.js and
Stylesheet.css files in the mobile workflow package are maintained and functional
after regenerating and repackaging.

• Any customizations made in previous versions of the API.js, Utils.js, or
WorkflowMessage.js files in the mobile workflow package are backed up (to
a .backup extension) the first time the mobile workflow package is generated in 2.1 ESD
#2, then they are replaced with the new 2.1 ESD #2 version. If you made changes to those
files in previous versions, you must manually reapply those changes.

• Mobile workflow packages generated in previous versions do not work with version 2.1
ESD #2 of Unwired Server unless you manually modify the manifest.xml file to
reference the shared WorkflowClient.dll file located in
UnwiredPlatform_InstallDir\UnwiredPlatform\Servers
\MessagingServer\Bin.

• For workflows generated in previous versions, the custom.js and stylesheet.css
files are backed up before being overwritten. Each backup file is created in the same
directory with .backup appended to the original name.

Upgrading and Migrating
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• If projects created before 2.1 ESD #2 have controls without labels, after migrating to 2.1
ESD #2, error markers appear. You must manually add any missing labels after migrating
to 2.1 ESD #2.

Supported Upgrade Scenarios
When Unwired Server is upgraded to version 2.1 ESD #2, no modifications to the earlier
deployed versions of Hybrid Web Containers on the server or clients are necessary for the
same functionality to operate correctly.

When SDK clients are upgraded from version 2.0 or 2.0.1 to version 2.1.x, version 2.0 and
2.0.1 coexist with 2.1.x on BlackBerry and Windows Mobile platforms. Workflow messages
and existing version 2.0 mobile workflows remain on the clients. Native applications continue
to use version 2.0 or 2.0.1 binaries and settings.

You can install Mobile Workflow applications of different versions, for example, 2.1 and 2.1
ESD #1 on the same device, but if they have the same AppID and same device ID, they cannot
connect to the same Unwired Server. Mobile Workflow applications with different AppIDs
installed on the same device can connect to the same Unwired Server.

Android
If the 2.1 ESD #2 Android Hybrid Web Container is installed on an Android device in which
the previous version of Android Hybrid Web Container is already installed:

• The later version of the container upgrades and replaces the previous version of the
container.

• Existing mobile workflow applications and messages stay intact and are automatically
mapped to the 2.1 ESD #2 Hybrid Web Container.

• No new registration or re-registration is required on Unwired Server, nor do you need to
reassign mobile workflows to the 2.1 ESD #2 Hybrid Web Container.

BlackBerry
If the 2.1 BlackBerry mobile workflow container is installed on a BlackBerry device on which
an earlier version of BlackBerry Hybrid Web Container is already installed:

• The Hybrid Web Containers coexist on that BlackBerry device or simulator.
• The existing mobile workflow applications and messages remain tied to the earlier version

of the container and are not removed.
• A new application connection on Unwired Server is required for the 2.1 ESD #2 container,

mobile workflows must be assigned to the 2.1 ESD #2 container, and the connection
settings must be entered in the 2.1 ESD #2 application.

iOS
If the 2.1 ESD #2 Hybrid Web Container is installed on an iOS device on which the 2.0, 2.0.1,
or 2.1 iOS Hybrid Web Container is already installed:

Upgrading and Migrating
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• The version 2.1 ESD #2 Hybrid Web Container replaces the 2.0, 2.0.1, 2.1, or 2.1 ESD #1
container.

• Existing mobile workflow applications and messages stay intact and are automatically
mapped to the 2.1 ESD #2 container.

• No new registration or re-registration of application connections is required on Unwired
Server, nor do mobile workflows need to be reassigned to the 2.1 ESD #2 container.

Windows Mobile
If the version 2.1 ESD #2 Hybrid Web Container is installed on a Windows Mobile device on
which the 2.0, 2.0.1, 2.1, or 2.1 ESD #1 Hybrid Web Container is already installed:

• The two Hybrid Web Containers coexist on that Windows Mobile device or emulator.
• The existing mobile workflow applications and messages remain tied to the version 2.0,

2.0.1, 2.1, or 2.1 ESD #1 Hybrid Web Container and are not removed.
• A new application connection on Unwired Server is required for the 2.1 ESD #2 container,

mobile workflows must be assigned to the 2.1 ESD #2 container, and the connection
settings must be entered in the 2.1 ESD #2 mobile workflow application.

• When the 2.1 ESD #2 container is installed, and a version 2.0, 2.0.1, 2.1, or 2.1 ESD #1
installation is present, an additional Workflow menu item is not added to the menu in the
mail application. The existing Workflow menu item in the Messages application maps to
the 2.0, 2.0.1, or 2.1 container.

• Workflow messages in the inbox open whichever container version they are associated
with. If 2.0 or 2.0.1, or 2.1.x are assigned to the same workflow and have messages sent to
the user, two e-mail messages are sent — one for each registration.

The Windows Mobile Programs folder has icons for accessing 2.0, 2.0.1, and 2.1 settings.
Versions 2.0 and 2.0.1 icons and names remain. For 2.1.x, two new icons are present—
Workflow Settings for the 2.1.x settings application and Sybase Mobile Workflow for the
2.1.x workflow application.

OData SDK Client Version Compatibility Matrix
Compatibility between versions of OData SDK clients and Unwired Server.

OData SDK Client and Unwired Server Version Compatibility

OData SDK Cli-
ent

Unwired Server
2.1

Unwired Server
2.1 ESD #1

Unwired Server 2.1
ESD #2

OData SDK Client 2.1 Yes Yes Yes

OData SDK Client 2.1
ESD #1

No Yes Yes
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OData SDK Cli-
ent

Unwired Server
2.1

Unwired Server
2.1 ESD #1

Unwired Server 2.1
ESD #2

OData SDK Client 2.1
ESD #2

No Yes Yes

Updates to Supported Operating Systems

Sybase Unwired Platform now supports more operating systems.

Unwired Platform 2.1 ESD #2 contains updates which include support for:

• Apple iOS 6.1.x (for Native OAPI and OData application development in backward
compatibility mode only)

• Apple iOS 6.0 (for Native OAPI and OData application development in backward
compatibility mode only)

• BlackBerry 7.0 and 7.1 (for Native OAPI and OData application development only)

For a complete list of supported platforms and operating systems, see Supported Platforms
and Development Environments in the Supported Hardware and Software guide.

Updates to Certified Devices

Sybase Unwired Platform now supports more devices.

The iPhone 5, iPad Mini, and iPad with Retina display and A6X chip have been certified for
the following applications:

• Object API Applications (in Apple’s backward compatibility mode)
• OData SDK Applications (in Apple’s backward compatibility mode)

Changed or Deprecated Features

Some Sybase Mobile SDK behavior has changed or been deprecated.

Updates to Supported Operating Systems
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CR # Description

696706 The Query Limiting feature in Sybase Unwired WorkSpace – Mobile Business
Object Development is deprecated.

Workaround: Use either an object query or Object API dynamic query to achieve
the same effect as when the Query Limiting check box is selected.

CSN
0120061532
3869546 2011

OData BlackBerry deprecations for API.

getSignedCertificateFromStore() is deprecated and the pop-up
screen has been removed from the new API Certificate Selection.

CR-690900 Bulk download methods deprecated for APIs.

Bulk download methods have been deprecated in Windows Mobile and Win32 APIs.
Sybase recommends that you update the initial loading model for newly deployed
applications. Existing customers will be supported, but only until the functionality is
fully removed. See the corresponding Mobile Data Models guide for alternate im-
plementations.

684329 Backward compatibility issue for synchronization parameters.

After upgrading Unwired Server to 2.1 ESD #2, when generating new code, you
must modify the synchronization parameters code to properly trigger a cache refresh
so that data gets updated from the backend to the client.

Workaround: Modify client code: after saving sync parameters, explicitly call the
DBClass BeginSynchronize() method.

Known Issues with Installing, Uninstalling,
and Upgrading

Learn about known Sybase Mobile SDK installation, uninstallation and upgrade issues and
workarounds.

See the Installation Guide for Sybase Mobile SDK for upgrade and migration information.

Known Issues with Installing, Uninstalling, and Upgrading
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Issue
Number

Description

CR 692901 Requirements for using SAP® JCO 3 on Windows XP.

If you plan to use SAP JCO 3 in Unwired WorkSpace running on Windows XP, JCO 3
requires Microsoft Visual C++ 2005 Service Pack 1 Redistributable.

Note: This is not a requirement for Windows 7 or 64-bit Windows Server 2008 system.

Workaround: Install the Microsoft Visual C++ 2005 Service Pack 1 Redistributable.

Obtain the Microsoft Visual C++ 2005 Service Pack 1 Redistributable from: http://
www.microsoft.com/download/en/details.aspx?displaylang=en&id=14431.

You can install the service pack after installing the 2.1 ESD #2 upgrade if you discover
you need it.

Known Issues for Sybase Unwired WorkSpace
– Mobile Business Object Development

Learn about known issues and apply workarounds for Unwired WorkSpace and mobile
business object (MBO) development.

Issue
Number

Description

CR
695596

R

Removing subsequent MBO during MBO creation fails.

For example:

1. Drag and drop a Web service that contains two XSLTs.
2. Unselect the subsequent MBO in the "Create mobile business objects" page, and

click Finish.
3. Two MBOs are generated.

Unselecting the subsequent MBO in the "Create mobile business objects" page should
result in generation of only one MBO. This applies to Web service, SAP, and RESTful
data sources.

Workaround: Manually remove the subsequent MBO from the Mobile Application
Diagram after finishing the MBO creation wizard.

Known Issues for Sybase Unwired WorkSpace – Mobile Business Object Development
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Issue
Number

Description

CR
695589

If you choose a simple datatype as an output parameter while creating an MBO
operation from an SAP EIS using the MBO Operation Creation wizard, the output
mapping page does not list the simple type parameter, but does list structure pa-
rameters.

This may also generate a warning message similar to:

The output record of the 'CREATE' operation 
'MBOName->OperationName' 
with 'Apply results to the cache' option set does not con-
tain the primary key columns.
Workaround: You can safely ignore this message.

CR
695165

When creating an MBO or operation from a REST Web service data source, if you
select Response and specify an XSLT in the Representation tab, then choose Re-
quest and unselect Request again, the already selected XSLT for the Response is
cleared.

Workaround: Select an XSLT for the Response again if you unselect Request in the
Representation tab.

CR
694409

Deployment and code generation errors occur for MBOs that contain attributes
with BigBinary datatypes but do not have primary-key attribute(s).

In addition, this error appears during code generation and deployment:

Alternate keys are missing! Please check if all attributes 
are BLOB/CLOB types.
Workaround: Set MBO primary key attributes.

CR
690308

Open cursor does not work well for some kinds of MBOs.

For example, a BlackBerry opencursor wasNull() function may throw an
exception, while the C# version proceeds. This might happen if the return value from the
database on the device is incorrect.

Workaround: If you receive an opencursor exception, check the return value from the
device's database for possible clues.

CR
689859

Sybase Unwired Platform Unwired WorkSpace Welcome page moves to standby
mode after Eclipse is started.

This is due to a known Eclipse 3.7 bug (https://bugs.eclipse.org/bugs/show_bug.cgi?
id=355560). In standby mode, the Welcome page is docked to the right as a view in the
Mobile Development perspective, since the Problem View is part of the Mobile Devel-
opment perspective.

Workaround: Double-click the docked Welcome page to extend it to full screen.

Known Issues for Sybase Unwired WorkSpace – Mobile Business Object Development
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Issue
Number

Description

CR
689707

Default runtime values requirements.

For an MBO operation, a non-nullable argument must get its runtime value via one of the
following: client parameter, personalization key, default value, or fill-from-attribute. If a
non-nullable argument has fill-from-attribute or client parameter already, its default
value is ignored. Unwired WorkSpace still allows the user to input a default value.

Workaround: In this case, you need not set the default value, because it is not used
during runtime.

CR
688956

Unwired WorkSpace fails during preview or test execute.

When doing preview or test execute in Unwired WorkSpace during MBO development if
the data volume is large, for example, either a large number of rows, or a large object in
the returned result, Unwired WorkSpace may run out of memory and fail.

Workaround: Do not select Preview or Test Execute with large results, or increase the
Java VM argument, -Xss -Xms, and -Xmx in the UnwiredWorkSpace.bat to
increase the stack and memory (heap) size.

CR
688576

The Oracle datatype NCLOB is not supported.

Workaround: Convert the unsupported datatype to a supported datatype. Convert the
CLOBS datatype to a varchar datatype There are two ways to do this:

• Create a stored procedure and call it from the MBO. In the stored procedure, convert
the CLOBS to varchar

• Create this Transact-SQL® statement, which fetches 4000 bytes of the CLOB: se-
lect dbms_lob.substr( x, 4000, 1 ) from T.

The maximum varchar length allowed in Transact-SQL statements is 4000 bytes.
You can increase this to 32KB. To process the BLOB in this way, a Stored Procedure
is recommended. For example:

declare 
  my_var long; 
begin 
  for x in ( select X from t ) 
  loop 
    my_var := dbms_lob.substr( x.X, 32000, 1 );

.

CR
682651

Unwired WorkSpace does not support saving files as PDF.

Invoking File > Save As Image File from the Object Diagram context menu fails if PDF
is the image format.

This is a known Eclipse GMF bug. See https://bugs.eclipse.org/bugs/show_bug.cgi?
id=338380

Workaround: None.

Known Issues for Sybase Unwired WorkSpace – Mobile Business Object Development
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Issue
Number

Description

CR
677453

When Unwired WorkSpace is uninstalled and reinstalled in a different directory,
you get a ClassNotFoundException message if the old workspace is used and you
connect using the JDBC connection profile.

Workaround: Update the driver definition to point to the correct path:

1. From Unwired WorkSpace, select Window > Preferences > Sybase, Inc > Con-
nectivity > Driver Definitions.

2. Select the driver type, and click Edit to invoke the Edit Driver Definition dialog.
3. Click the Jar List tab, and edit the path of the JDBC driver.
4. Reimport any Mobile Application Projects that require the updated driver for con-

necting to the database.

CR
676634

For Web Service and other datasources with very complex structures with deeply
nested element trees, StackOverflow or OutOfMemory messages may occur, or
some of the operation input parameters may not be generated properly.

In some cases, you see this error:

The assigned stack size and/or heap size is 
not sufficient for the attempted operation.
Workaround: Increase the stack and heap size of the Eclipse runtime parameter in
UnwiredWorkSpace.bat with -Xmx, -Xms, -Xss arguments, or reduce the
complexity or nested level of the Web Service definition of the MBO operation.

CR
642942

Cannot generate code with Javadoc option enabled to a folder containing Chinese
characters.

When using the code generation wizard, if you enable the option to generate Javadoc, you
cannot generate the code to a folder containing Chinese characters without first changing
the language for non-Unicode programs to Chinese.

Workaround:

1. Select Start > Settings > Control Panel.
2. Double-click Regional and Language Options, then click the Advanced tab.
3. From the drop-down list, select Chinese, and click Apply.
4. Click OK.

Known Issues for Sybase Unwired WorkSpace – Mobile Business Object Development
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Known Issues for Sybase Unwired WorkSpace
– Mobile Workflow Package Development

Learn about known issues and apply workarounds for Unwired WorkSpace and Mobile
Workflow application development.

Issue
Number

Description

CR
694874

In iOS, pop-up menu item selections within a Mobile Workflow application stay
open.

The pop-up menu stays open after a selection is made, instead of closing as expected.
Making additional selections of the same menu item are ignored. This behavior is ob-
served only with many menu selections in a single screen (~12+).

Workaround: Click Cancel to close the pop-up window.

CR
694665

AsyncRequestErrorLogs key not generated in a migrated project.

If you migrated a Mobile Workflow project that previously contained a submit workflow
action, setting its error screen property does not generate the AsyncRequestErrorLogs
list key.

Workaround: Create a new Submit Workflow action, or click the Generate Error
Screen button.

CR
694652

In Mobile Workflow applications generated with a 2.0 version of the Mobile Work-
flow Package generation wizard, running on an iPad iOS 5 and running in a 2.1.2
container, edit boxes that should be editable may not be editable.

Workaround: Regenerate and redeploy the Mobile Workflow application using a 2.1.2
version of the Mobile Workflow Package generation wizard.

Known Issues for Sybase Unwired WorkSpace – Mobile Workflow Package Development
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Issue
Number

Description

CR
694232

When a Mobile Workflow package is deployed in Replace mode, the subscription
information is not removed from the server side.

Even though the Mobile Workflow application is unassigned on the client side, the
subscription information still shows the package is assigned to the user in Sybase Control
Center.

Workaround: Remove the subscription information manually:

1. Log in to Sybase Control Center.

2. Go to Applications > Application Connections.

3. Select the user account, then select Package Users.

4. Click Delete.

CR
690460

On BlackBerry devices, in most cases, the module name is the same as the module
display name, but if there is a case when the module name ! = module display name,
it causes issues.

Workaround: None.

CR
690438

A workflow does not initiate an operation.

This could happen if the workflow is not constructed correctly.

On a Listview details screen, you cannot invoke a submit workflow to invoke an MBO
operation that uses child keys of the list key that is bound to that listview. To prevent
developers from performing an illegal operation, the keys are removed from the list.
However, you can see those keys before making the workflow type operation a Listview
details screen because it is not illegal in that circumstance; it is only illegal once you
make it a Listview details screen. If you use those keys when it is not a Listview details
screen and then make it a Listview details screen, the workflow operation will fail with
no indication of the problem.

Workaround:

Client-initiated workflow: verify that no online request operations (such as findall)
precede the submit workflow type operation. If so, remove the operations.

Server-initiated workflow: verify that no links (between the start point and the first
screen saved) precede the submit workflow operation. If so, remove the links.

CR
684635

Choice controls with a large number of rows do not behave as expected on some
platforms.

Workaround: For best performance, keep the number of rows in choice controls under
200.

Known Issues for Sybase Unwired WorkSpace – Mobile Workflow Package Development
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Issue
Number

Description

CR
682741

Validate controls as soon as the user tries to change focus away from them option in
Mobile Workflow Package generation wizard is not supported on Windows Mobile.

Workaround: None.

CR
681918

When you click the Workflow icon on iOS devices, you see the message Sybase
Mobile Workflow please go to the settings applica-
tion and enter your configuration....

This happens if you attempt to open a version 2.0 Workflow on the iOS device and
connect to version 2.1 of Unwired Server.

Workaround: In Sybase Control Center, use the HWC template to create an application
connection and leave the application identifier empty.

CR
678440

On BlackBerry devices, you receive an error when running an HTTPS GET meth-
od from the Mobile Workflow

Workaround: Refer to the BlackBerry Knowledge Base article at http://btsc.we-
bapps.blackberry.com/btsc/search.do?cmd=displayKC&docType=kc&external-
Id=KB20833&sliceId=1&docTypeID=DT_SUPPORTISSUE_1_1&dialog-
ID=1652002964&stateId=0%200%201652004660.

CR
677684

Locale properties file is not updated if screens, controls, menu items and so on are
removed.

During Mobile Workflow package generation, you see a warning that validation keys are
missing from the locale.properties file if screens, controls, menu items and

so on have changed in number, for example, if you deleted a menu item. Resource strings
associated with screens, controls, and menu items do not correctly update the sequence.

Workaround: Either do not remove screens, controls, menu items and so on after
localizing, or manually correct the localization .properties file after making the

changes.

Known Issues for Sybase Unwired WorkSpace – Mobile Workflow Package Development

Release Bulletin for Sybase Mobile SDK 23

http://btsc.webapps.blackberry.com/btsc/search.do?cmd=displayKC&docType=kc&externalId=KB20833&sliceId=1&docTypeID=DT_SUPPORTISSUE_1_1&dialogID=1652002964&stateId=0%200%201652004660
http://btsc.webapps.blackberry.com/btsc/search.do?cmd=displayKC&docType=kc&externalId=KB20833&sliceId=1&docTypeID=DT_SUPPORTISSUE_1_1&dialogID=1652002964&stateId=0%200%201652004660
http://btsc.webapps.blackberry.com/btsc/search.do?cmd=displayKC&docType=kc&externalId=KB20833&sliceId=1&docTypeID=DT_SUPPORTISSUE_1_1&dialogID=1652002964&stateId=0%200%201652004660
http://btsc.webapps.blackberry.com/btsc/search.do?cmd=displayKC&docType=kc&externalId=KB20833&sliceId=1&docTypeID=DT_SUPPORTISSUE_1_1&dialogID=1652002964&stateId=0%200%201652004660


Issue
Number

Description

CR
675904

Object queries in the Online cache group are case-sensitive.

If the enterprise information system (EIS) to which an object query is associated has
case-sensitive parameters, then the client must pass matching parameters or no data is
returned. For example, if the Customer MBO is in an Online cache group, has a load
parameter "state" that is propagated to the attribute "state," and a findByParameter object
query defined as:

SELECT x.* FROM Customer x WHERE x.state = :state 

No data is returned to the client if they enter state=Ca, since the database parameter

is case-sensitive (CA). This is not an issue for object queries in other types of cache
groups.

Workaround: None.

CR
674149

Exception received with large amounts of data.

When the amount of data is too large to download to the workflow client device, you may
get an exception similar to:

"iAnywhere.MobileOffice.AMP.ResponseRetryException" on 
device, and following error in WorkflowClient.log: 

20110616T110249.554|4|My:1 -- ExecuteRequest- > Out 
20110616T110249.694|1|iAnywhere.MobileOffice.AMP.Respon-
seRetryException: Exception of type 
'iAnywhere.MobileOffice.AMP.ResponseRetryException' was 
thrown. 
20110616T110249.694|1| at Sybase.UnwiredPlatform.Work-
flowClient.Utils.CheckMessageSize
(String serializedMessage, ContextData oContextData, Boo-
lean fromResponder) 
20110616T110249.694|1| at Sybase.UnwiredPlatform.Work-
flowClient.Responder.ProcessMessageFromDevice
(ContextData oContextData, String sData, Boolean isSyn-
chronous) 
20110616T110249.694|1| at Sybase.UnwiredPlatform.Work-
flowClient.Responder.ProcessSyncRequest
(ContextData oContextData, String sData) 
20110616T110249.694|4|My:1 -- ProcessSyncRequest- > Out

Workaround: Increase the allowed maximum workflow message size (SupMaximum-
MessageLength). From Sybase Control Center, expand Workflows and select the work-
flow of interest. Select the Context Variables tab. Modify the property.

Known Issues for Sybase Unwired WorkSpace – Mobile Workflow Package Development
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Issue
Number

Description

CR
673572

Workflows do not work with Android simulators version 2.3.3.

See http://code.google.com/p/android/issues/detail?id=12987 for a description of this
issue.

Workaround: Use an earlier version of the Android simulator.

CR
671242

Submit operation is empty if the workflow uses a Web Service that takes a structure
as its input.

While you can add items to the listview and save the list, when you submit the operation,
it is empty. Array/list fields in structure parameters are not supported. You can have a
top-level parameter that is an array/list, and you can have a top-level parameter that is a
structure that has non-array/list fields and substructures.

Workaround: None.

CR
669251

On a BlackBerry AsiaBB9800 simulator, data with the DATETIME type does not
display in certain circumstances.

Workaround: None.

CR
667325

On BlackBerry 5.0, if there is a dynamic choice on the screen, labels for the drop-
down and comments fields overlap, which hides the drop-down control.

This happens only on some BlackBerry 5.0 devices, and only intermittently.

Workaround: If you know where to click for the drop-down, you can access the drop-
down control, and it accepts your choice.

CR
667187

The BlackBerry Bold 9700 device simulator sometimes does not allow the user to
have full control of the screen for an application, and may perform the wrong
operations, and return the wrong results. Real devices work correctly.

Workaround: None.

CR
666672

On BlackBerry 6.0 simulators (non-touch models), it is difficult to enter the pass-
word.

Workaround: There are two workarounds for this issue:

1. When the password control has focus, press the scroll button and scroll to the left,
then it accepts input.

2. When the password control has focus, press the Menu button, choose Select, and
then move the cursor to the password control.

CR
628826

Cannot copy and paste with multiple objects.

Workaround: Copy and paste only one Listview or Htmlview at a time.

Known Issues for Sybase Unwired WorkSpace – Mobile Workflow Package Development
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Known Issues for Native Object API

Learn about known issues and apply workarounds for Native Object API and custom
development.

Issue
Number

Description

CR
707244

ARC applications fail due to SUPApplication and SUPBASICTYPES implemen-
tation.

If you use ARC (memory management for iOS) in development, for example, with iOS 5
when creating Object API applications, the ARC applications will fail. The singleton
implementation in SUPApplication and SUPBASIC TYPES is incorrect.

Workaround: Request patch from CS&S.

CR
692374

Enabling compression incurs additional processing on the device and the server
side to optimize the amount of data to be transferred over the network.

Workaround: Carefully evaluate whether the compression trade-off is appropriate in
the deployment environment, and carefully size the server capacity to support it. If
appropriate in a particular environment, follow the Sybase Unwired Platform Developer
Guides to enable compression.

CR
675716

SQLite cannot support create operations with more than 3MB of data, which is
roughly 128 columns at 64KB per column on Windows Mobile devices.

In Windows Mobile applications that use message-based synchronization, when a row
reaches 3MB or more, and the client invokes the SQLite create operation during sub-
scription, an internal exception is generated, data import fails, and the import operation
fails to commit the transaction.

Workaround: Use bulk load instead of the common subscribe, which first initializes the
client database, then downloads the database from Unwired Server to the client.

Known Issues for Hybrid Web Container

Learn about known issues and apply workarounds for Hybrid Web Container (HWC)
development.

Known Issues for Native Object API
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Issue
Number

Description

CR
722779

Hybrid Workflow Application does not use the full screen on iPhone5

The Hybrid Workflow Application does not use the full screen on iPhone5. In portrait
mode, narrow black bars appear on the top and bottom of the screen. In landscape mode,
narrow black bars appear along the left and right side of the screen.

Workaround: None.

CR
721056

Date/time picker does not open for iOS 6.0

The date and time picker does not pop up in iOS 6.0. This is not an issue on iOS 5.1.1.

CR
705219

When the iOS Hybrid Web Container application tries to retrieve seeding information
from an Afaria® iOS App store hosted package you receive an error message:

Afaria client application is installed but not con-
figured. Please configure Afaria client application
and try again or go to the Settings application and
enter your configuration information.

Workaround:

• Seeding works for Enterprise hosted packages on the Afaria server.
• You can still manually configure the connection information.

CR
701485

'PictureOption.PictureSourceType' [undefined] is not an object.

In custom.js, the customGetPictureDataFromCamera() and custom-
GetPictureDataFromLibrary() methods contain a typographical error in
the camera source type.

Workaround: Change the PictureOption.PictureSourceType.CAMERA to PictureOp-
tion.SourceType.CAMERA.

CR
693907

Hybrid Web Container occasionally fails on Android.

This can happen when all of these conditions are present:

• There is only one edit box control on a single screen
• Using jQueryMobile GA version
• On Samsung Galaxy devices with Android 2.2

Workaround: Either:

• Upgrade the OS on the device to Android 2.3, or
• Add controls to the screen (even one more would suffice)

Known Issues for Hybrid Web Container
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Issue
Number

Description

CR
693381

Cannot preview a selected picture on Windows Mobile emulator.

When using the imageElement.src = imageUri in the getPicture function, you cannot
preview the selected image on the Windows Mobile emulator. This is because the HTML
browser adds an unexpected prefix to the URI, so the Hybrid Web Container cannot find
the file to which the URI refers.

Workaround: Either:

• Preview the image using an actual device instead of the emulator, or
• Assign image data instead of image URI to the image element so the image data can

be retrieved through the JavaScript API

CR
691005

Image upload may fail on BlackBerry 6 simulators older than version 6.0.0.499.

Workaround: Use a BlackBerry 9800 simulator with version 6.0.0.499 or later.

CR
690013

In iOS, the Listview in a Scroll screen does not zoom in or out well.

A pinch-to-zoom gesture must use some of the screen background and/or the header or
footer. On a Listview screen (particularly one with many rows), there may not be any
background revealed, making it appear that pinch-to-zoom is disabled, when it is not.

Workaround: The gesture can use some small amount of background space surround-
ing the Listview, combined with the header or footers. Also, zooming can be toggled
(Zoom In/Zoom Out) by clicking the title in the header.

CR
688399

On Windows Mobile devices, thumbnails do not show properly if an image has a
large size.

Workaround: The root cause is that Internet Explorer cannot load a large image; try one
of these solutions to address the image size:

Solution 1: Specify a small-sized image as the thumbnail instead of using the original
large image, for example:

<img src="default-thumbnail.jpg" width="120" 
height="120" id="Thumbnail" sup_static_op-
tions="true" name="Preview" alt="Preview"/>
Solution 2: Pass the width and height as the parameters in the source of the image
control, so the container compresses the original image on the fly, for example:

<img src="default.jpg?width=120&height=120" 
width="120" height="120" id="Thumbnail" sup_stat-
ic_options="true" name="Preview" alt="Preview"/>
The width and height parameters are supported only on Windows Mobile and may cause
display issues on other platforms.

Known Issues for Hybrid Web Container
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Issue
Number

Description

CR
686465

Camera feature is supported on some device simulators/emulators.

• Android 2.2: not supported, http://code.google.com/p/android/issues/detail?
id=9376.

• BlackBerry: supported.
• iOS: not supported.
• Windows Mobile: supported; however, can photograph only a grey/black screen.

Workaround: None.

CR
680253

Images do not appear correctly on mobile devices.

Hybrid Web Container/Workflow applications can display pictures from binary enter-
prise information system (EIS) data. But when a MBO developer drags and drops a table
that contains an image field to create the MBO, the image field maps to a Binary datatype
that has a length of approximately 3KB, which may not be large enough for the entire
image. At runtime, the binary data of the image may be truncated in the cache database
(CDB), and not appear correctly on the device.

Workaround: When creating the MBO, manually modify the length of the binary field
to make sure it is large enough to hold the image binary data, or use the BigBinary
datatype instead.

Known Issues for MAKit

Learn about known issues and apply workarounds for MAKit development.

Issue
Number

Description

CR
733167

When opening a MAKit PDF from the Product Documentation Web site, some
users may be prompted to update Adobe Flash Player.

When some users attempt to open the MAKit Developer Guides at http://sybooks.syb-
ase.com/sybooks/sybooks.xhtml?id=1289&amp;c=firsttab&amp;a=0&amp;p=cate-
gories, they may get an error stating an updated version of Flash is required to view the
PDF package.

Workaround: Update to the most recent version of both Adobe Reader and Adobe
Flash Player by visiting the Adobe Downloads Web site at http://www.adobe.com/
downloads/.

Known Issues for MAKit
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Documentation Issues and Updates for Mobile
SDK

Read about updates, corrections, and clarifications to the documentation released with Sybase
Unwired Platform 2.1 ESD #2.

Issue
Number

Description

None Do not compile and run the example projects

The following note was omitted from the prerequisites in the 2.1.2 Tutorials:

Do not try to compile and run the tutorial example projects posted in http://scn.sap.com/
docs/DOC-8803#section2. They are meant only as code examples.

This applies to:

• Tutorial: Android Object API Application Development
• Tutorial: BlackBerry Object API Application Development
• Tutorial: iOS Object API Application Development
• Tutorial: Windows Mobile Object API Application Development
• Tutorial: Mobile Workflow Package Development

NA2-1743 Corrected user authentication information

In the topic Logging In, the second paragraph incorrectly lists the startConnection
method as an appropriate method for user authentication. The paragraph should read:

Authenticate the user for data synchronization by calling the generated database API
beginOnlineLogin method.

This topic is found in:

• Developer Guide: Android Object API Applications > Developing the Application
Using the Object API > Initializing an Application > Initially Starting an Applica-
tion

• Developer Guide: BlackBerry Object API Applications > Developing the Appli-
cation Using the Object API > Initializing an Application > Initially Starting an
Application

• Developer Guide: iOS Object API Applications > Developing the Application
Using the Object API > Initializing an Application > Initially Starting an Applica-
tion

• Developer Guide: Windows and Windows Mobile Object API Applications > De-
veloping the Application Using the Object API > Initializing an Application >
Initially Starting an Application
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Issue
Number

Description

CR
730839

REST Service endpoint does not support JSON

In the topic REST Web Services in Sybase Unwired WorkSpace - Mobile Business
Object Development the statement:

"Supports resources with multiple representations (Transfer XML, JavaScript Object
notation(JSON), or both)"

is not correct. The REST Service endpoint does not support JSON, so resources with
multiple representations are not supported.

CR
716466

The topic Retrieving Information About Synchronization Groups does not apply
to iOS

The topic Retrieving Information About Synchronization Groups in Developer Guide:
iOS Object API Applications is not relevant to iOS.

CR
714445

DCN syntax and example use incorrect JSON format in user documentation.

References in the Developer Guide: Mobile Workflow Packages > Mobile Workflow
DCN Without Payload topic are not valid JSON, because the data value is an object and
should be an array, and there is an extra colon. For example, this syntax is incorrect:

 {”id”:””,”op”:”:”,”sub-
ject”:””,”to”:””,”from”:””,”read”:,”priority”:,
”body”:””, “data{}} 
And should be:

 {”id”:””,”op”:”:upsert”,”sub-
ject”:””,”to”:””,”from”:””, ”read”:,”priori-
ty”:, ”body”:””, 
”data”:[]} 
And this example:

{”id”:””,”op”:”:”,”sub-
ject”:”test”, ”to”:”test”,”from”:”test”,”read”:, 
”priority”:,”body”:” MATCH:SUP_MWF,TaskID:TS97200149, 
WIID:1470577, USER:PERF0111*#END#*”, "data”{}}
Should be:

 {”id”:””,”op”:”:upsert”,”sub-
ject”:”test”,”to”:”test”,”from”:”test”,”read”:, ”priori-
ty”:,
”body”:” MATCH:SUP_MWF,TaskID:TS97200149, WIID:1470577, 
USER:PERF0111*#END#*”,”data”:[]}
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Issue
Number

Description

CR
709807

Updated result checker documentation.

Result checkers are now implemented through the OperationHandlerBase class, which
replaces the ResultChecker class.

These topics have been added to Result Checkers in the Mobile Data Models: Using
Mobile Business Objects 2.1 ESD #2.

CR
708703

SAPResultChecker information is missing from Sybase Unwired WorkSpace - Mo-
bile Business Object Development and Mobile Data Models: Using Mobile Business
Objects.

The following topics cover the missing information:

• Editing the Result Checker on page 36
• Writing a Custom Result Checker on page 36
• Result Checker Logging on page 39

CR
705560

Updated parameter and synchronization documentation.

This change affects these topics in the Android, BlackBerry, iOS, and Windows and
Windows Mobile Object API Applications Developer Guides:

• Nonblocking Synchronization
• Specifying Personalization Parameters
• Specifying Synchronization Parameters

You must set and save both the personalization and synchronization parameters.

• Add this information to Specifying Personalization Parameters and Specifying
Synchronization Parameters.

Note: If a synchronization parameter is mapped to a personalization parameter, no
data is downloaded to the device until that mapped personalization parameter is set
and saved."

• In Nonblocking Synchronization, add this step 2, or modify the existing step 2 to
include:
If there are personalization parameters and synchronization parameters, set and save
them before making the first full synchronize call.

PersonalizationParameters pp = SUP101DB.getPersonali-
zationParameters(); pp.setPKCity( "New York" ); 
pp.save();
CustomerSynchronizationParameters sp = Customer.get-
SynchronizationParameters(); sp.setCityname("Kansas 
City"); sp.save();
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Issue
Number

Description

CR
702795

How Passwords Are Stored on a Device.

Best practices and security audits require you to know how passwords are stored on a
device. The Sybase Unwired Platform environment using native object APIs does not
automatically store passwords on a device. It does support you using a secure DataVault
to store passwords or using an offlineLogin feature.

The DataVault API is the recommended feature to use a password to access the appli-
cation's sensitive data on the device. To use DataVault, you first create the application,
an encryption key, the database, and a DataVault. You then create the log-in screen and
display it during application startup. It calls the DataVault API to validate the one
password entry. You must enter the password to unlock the application and provide
access to any on-device data.

DataVault stores sensitive data securely such as the encryption key used to encrypt/
decrypt the on-device database and the user's password. With that one valid password,
the Unwired Platform application retrieves the database encryption key from the Da-
taVault and uses that to open the encrypted on-device database.

Create a DataVault using the Security APIs section of the Developer Guide for the
device you are using.

The offlineLogin feature uses a username and password to access the on-device data. To
use the feature, you first create the application, an encryption key, and the database. A
hashcode of your password is computed and applied automatically the first time you
synchronize the application. It is stored in the offlineLogin table. You then create the
log-in screen and display it during application startup. It calls the offlineLogin API to
validate the username and password entries. You must enter the credentials to unlock the
application and provide access to any on-device data.

You can access the data locally without Unwired Server communications. You must
know the Unwired Platform username and password to log in. If successful the process
authenticates the current credentials against the last successfully authenticated creden-
tials and provides access to the on-device data.

Note: The DataVault replaces the offlineLogin feature, which older applications may
use to provide some security for on-device data.

CR
698385

Running multiple applications on iOS simulator is not supported.

This affects Testing Applications in the Developer Guide: iOS Object API Applica-
tions.

On a device, multiple applications are supported as expected (App1 uses App1 PIN and
App2 uses App2 PIN after multiple launches); however, this multiple application sup-
port is not possible with the iOS simulator.
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Issue
Number

Description

CR
697632

Incorrect path for Workflow Client files in tutorials.

In Tutorial: Mobile Workflow Package Development > Developing the Mobile Work-
flow Package > Installing the Mobile Workflow Package > Configuring the BlackBerry
Simulator > Configuring the Mobile Workflow in the BlackBerry Simulator, step 4
gives the incorrect path for the Workflow client files.

The document states that they are located in C: Sybase\UnwiredPlatform
\MobileSDK\ClientAPI\Workflow\BB; however, they are located in
UnwiredPlatform_InstallDir\UnwiredPlatform\Mobi-
leSDK\HybridWeb\BB.

In Tutorial: Mobile Workflow Package Development > Developing the Mobile Work-
flow Package > Installing the Mobile Workflow Package > Configuring the Windows
Mobile Emulator > Installing Sybase Messaging Runtime, step 5 gives the incorrect
path for the SybaseMobileWorkflow.cab file.

The document states that the CAB file is located in: UnwiredPlatform_In-
stallDir\ClientAPI\Workflow\WM; however, the CAB file is located in
UnwiredPlatform_InstallDir\UnwiredPlatform\Mobi-
leSDK\HybridWeb\WM.

CR
692374

The topic Synchronization Profile in Developer Guide: Windows and Windows Mobile
Object API Applications > Client Object API Usage incorrectly states that compression
is enabled by default. By default, compression is not enabled.
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Issue
Number

Description

CR
691080

Adding local resources to a Mobile Workflow project.

When loading resources using custom JavaScript, be aware of the folder structure.
Depending on localization, the structure and path to the local resource may be different.
Possible folder paths include:

• .../html/default/workflow.html
• .../html/locale/workflow.html
• .../html/workflow.html
Referencing custom resources in HTML elements requires the use of relative URLs.
The parent directory may be the HTML directory, the root, or something else. There is
no guarantee that the URL structure is always http://hostname/html/
workflow.html. It is possible to copy the resources into each localization direc-
tory or reference the resources from one directory (paying attention to localization
paths).

An example of a useful helper function to get the relative path to the HTML directory
is:

/**
 * Returns relative URL to the html directory
 */
function getRelativeRoot()
{
   return ((resources != null) ? "../" : ""
}

// Helper function usage
var imageElement = document.getElementById("ImageEle-
ment");
imageElement.src = getRelativeRoot() + "images/my-
Image.gif";
This affects Mobile Workflow Development in the Developer Guide: Mobile Workflow
Packages.

CR
674889

Apple Push Notification Service (APNS) Works on iPad Devices.

These topics incorrectly state that APNS cannot be used with iPad devices:

• iOS Provisioning with APNS in System Administration
• Apple Push Notification Service Configuration in OData SDK Developer Guide

None Use a custom Java class to implement custom error checking.

See the topic Writing a Custom Result Checker.

None Use OHLog to trap warnings but not halt execution of the result checker.

See the topic Result Checker Logging.
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Issue
Number

Description

None The Developing Applications in the Blackberry Development Environment topic in
Developer Guide: OData SDK 2.1 ESD #2 incorrectly references APIs for Android
applications.

Editing the Result Checker
Change the result checker settings using the Change Definition dialog.

1. Right-click inside the Mobile Application Diagram and select Show Properties View, or
select Window > Show View > Properties.

2. In the Properties view, click the Attributes or Operations tab, then the Definition tab.

3. Click Edit.

4. Make your changes in the Change Definition dialog, and click OK.
SAP custom result checkers do not support the Unwired WorkSpace Preview option.

Writing a Custom Result Checker
Use a custom Java class to implement custom error checking.
Provide a Java class that extends the appropriate class for the enterprise information system
(EIS).
• SAP –

package com.sybase.sup.sap3;

import com.sap.conn.jco.JCoFunction;
import com.sybase.vader.core.OperationHandlerBase;

public abstract class SAPOperationHandler extends 
OperationHandlerBase {
 
 /**
  * 
  * @param f - JCO function that has already been executed. 
  * Use the JCO API to retrieve returned values and 
  * determine if the RFC has executed successfully.
  * 
  * Throw OHException to return an error.
  * Call OHLog.log() as often as needed to return 
  * warnings and other informational messages.
  */
 public void resultCheck(JCoFunction f) {
 }
 
 /** 
  * @param cause Exception thrown by the call to the EIS

Documentation Issues and Updates for Mobile SDK

36 Sybase Unwired Platform



  * 
  * @param f - JCO function that has already been executed. 
  * Use the JCO API to retrieve returned values and 
  * determine if the RFC has executed successfully.
  * 
  * Throw OHException to return an error.
  * Call OHLog.log() as often as needed to return warnings 
  * and other informational messages.
  */ 
 public void onError(Throwable cause, JCoFunction f) {
 }
}

• Web service (SOAP) –
package com.sybase.sup.ws.soap;

import com.sybase.vader.core.OperationHandlerBase;

public abstract class SoapOperationHandler extends 
OperationHandlerBase {

    /** 
     * 
     * @param response the SOAP Envelope response from 
     * a web service execute. 
     * Use the SOAP API to retrieve values and determine 
     * if the SOAP request has executed successfully. 
     * 
     * @param request the SOAP Envelope request sent to 
     * the web service. 
     * Use the SOAP API to retrieve values. 
     * 
  * Throw OHException to return an error.
  * Call OHLog.log() as often as needed to return warnings 
  * and other informational messages.
     * 
     */ 
 public void resultCheck(
      javax.xml.soap.SOAPEnvelope response, 
      javax.xml.soap.SOAPEnvelope request) {
 } 
 
    /** 
     * @param cause Exception thrown by the call to the EIS
     * 
     * @param request the SOAP Envelope request sent to the 
     * web service. 
     * Use the SOAP API to retrieve values. 
     * 
  * Throw OHException to return an error.
  * Call OHLog.log() as often as needed to return warnings 
  * and other informational messages.
  * 
     */ 
 public void onError(Throwable cause, 
   javax.xml.soap.SOAPEnvelope request) {
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 }
}

• RESTful Web service –
package com.sybase.sup.ws.rest;

import java.util.List;
import com.sybase.vader.core.OperationHandlerBase;

import java.net.URL;

public abstract class RestOperationHandler extends 
OperationHandlerBase{
 
 
 public RestOperationHandler () {
  super();
 }
 
 /** 
  * REST Result Check.
  *
  * @param responseBody HTTP response body.
  *
  * @param responseHeaders HTTP response headers in the form
  * {{header1,value1}, {header2,value2}, ...}.
  *
  * @param httpStatusCode HTTP status code.
  *
  * @param url HTTP URL.
  *
  * @param requestBody HTTP request body.
  *
  * @param requestHeaders HTTP request headers in the form
  * {{header1,value1}, {header2,value2}, ...}.
  *
  * Throw OHException to return an error.
  * Call OHLog.log() as often as needed to return warnings 
  * and other informational messages.
  * 
  **/ 
 public void resultCheck( String responseBody,
    List<List<String>> responseHeaders, int httpStatusCode, URL 
url,
         String requestBody, List<List<String>> requestHeaders) {
 }
 
    /** 
     * REST On Error
     * Note that errors are virtually never thrown by REST.  
     * Instead, HTTP Error codes are returned.  
     * The Result Check method can handle these codes 
     * before any exception is thrown by Data Services.
     * 
     * @param cause Exception thrown by the call to the EIS
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  *
  * @param url HTTP URL.
  *
  * @param requestBody HTTP request body.
  *
  * @param requestHeaders HTTP request headers in the form
  * {{header1,value1}, {header2,value2}, ...}.
     * 
  * @return Result Checker Return
  *
  * Throw OHException to return an error.
  * Call OHLog.log() as often as needed to return warnings 
  * and other informational messages.
  * 
     */ 
 public void onError(Throwable cause, URL url,
         String requestBody, List<List<String>> requestHeaders) {
 }
}

Result checkers depend on the Unwired Server sup-ds.jar file. For example,
<UnwiredPlatform_InstallDir>\Servers\UnwiredServer\lib\ext
\sup-ds.jar.

Result Checker Logging
Use OHLog to trap warnings but not halt execution of the result checker.

You can influence the error or warning code and message in the result checker by throwing a
DSException, which produces errors and halts execution, or by calling OHLog, which is
used for warnings and does not halt execution.

Use OHLog.log() to write to the client log. This method returns true if it successfully wrote
the log entry, and false if no client is defined. For example, no client is typically defined for
a scheduled refresh.

The following code examples illustrates implementation of OHLog for various enterprise
information systems.

Data Source: SAP
package com.sybase.vader.test.mms;

import com.sap.conn.jco.JCoFunction;
import com.sybase.sup.sap3.SAPOperationHandler;
import com.sybase.dataservices.OHException;
import com.sybase.dataservices.OHLog;

public class TestSAPOperationHandler extends SAPOperationHandler {

 public void resultCheck(JCoFunction f) {
  OHLog.warn(901, 101, f.toXML());
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  //throw new OHException(901, 101, "Throwing test OHException with 
901 and 101.");
  }
 
 public void onError(Throwable cause, JCoFunction f) {
  if(f !=null) {
   OHLog.warn(901, 101, f.toXML());
  } else {
   OHLog.warn(902, 102, "JCoFunction null");
  }
  throw new OHException(904, 103, "old exception said 
'"+cause.getMessage()+"'");
 }
}

Data Source: Web Service (SOAP)
package com.sybase.vader.test.mms;

import java.io.StringWriter;

import com.sybase.dataservices.OHException;
import com.sybase.dataservices.OHLog;
import com.sybase.sup.ws.soap.SoapOperationHandler;

import javax.xml.transform.OutputKeys;
import javax.xml.transform.TransformerFactory;
import javax.xml.transform.Transformer;

import javax.xml.transform.dom.DOMSource;
import javax.xml.transform.stream.StreamResult;

import javax.xml.soap.SOAPFault;
import javax.xml.soap.SOAPEnvelope;

public class TestSoapOperationHandler extends SoapOperationHandler {

 public void resultCheck(
      javax.xml.soap.SOAPEnvelope response, 
      javax.xml.soap.SOAPEnvelope request) {
   
  OHLog.info(901, 101, toXML(request));
  OHLog.warn(902, 102, toXML(response));
  
  try{
   SOAPFault fault = response.getBody().getFault();
   if(fault!=null) {
    throw new OHException(900, 
Integer.valueOf(fault.getFaultCode()), fault.getFaultString());
   }
  } catch (Exception e) {
   // ignore
  }
 } 
 
 public void onError(Throwable cause, 
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   javax.xml.soap.SOAPEnvelope request) {
  if(request != null) {
   OHLog.info(901, 101, toXML(request));
  }
  throw new OHException(904, 103, "old exception said 
'"+cause.getMessage()+"'");
 }
 
 private String toXML(javax.xml.soap.SOAPEnvelope env) {
  String xmlString="";
  try {
   TransformerFactory transfac = TransformerFactory.newInstance();
   Transformer trans = transfac.newTransformer();
   trans.setOutputProperty(OutputKeys.OMIT_XML_DECLARATION, "yes");
   trans.setOutputProperty(OutputKeys.INDENT, "yes");
 
   StringWriter sw = new StringWriter();
   StreamResult result = new StreamResult(sw);
   DOMSource source = new DOMSource(env);
   trans.transform(source, result);
   xmlString = sw.toString(); 
  }
  catch(Exception e) {
   
  }
  return xmlString;
 }
}

Data Source: RESTful Web Service
package com.sybase.vader.test.mms;

import java.net.URL;
import java.util.List;

import com.sybase.sup.ws.rest.RestOperationHandler;
import com.sybase.dataservices.OHLog;
import com.sybase.dataservices.OHException;

public class TestRestOperationHandler extends RestOperationHandler {

 public void resultCheck( String responseBody,
    List<List<String>> responseHeaders, int httpStatusCode, URL url,
         String requestBody, List<List<String>> requestHeaders) {

  OHLog.info(901, 101, url.toString());
  if(requestBody != null) {
   if(requestBody.isEmpty()){
    OHLog.debug(902, 102, "request body empty");
   }
   else {
    OHLog.debug(902, 102, requestBody);
   }
  } else {
   OHLog.debug(902, 102, "request body null");
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  }
  int i=0;
  for(List<String> list : requestHeaders) {
   String msg = "" + list.get(0) + "=" + list.get(1);
   OHLog.warn(903, i++, msg);
  }

  OHLog.info(905, 105, "httpStatusCode="+httpStatusCode);
  if(responseBody != null) {
   if(responseBody.isEmpty()){
    OHLog.debug(906, 106, "response body empty");
   }
   else {
    OHLog.debug(906, 106, responseBody);
   }
  }
  else {
   OHLog.debug(906, 106, "response body null");
  }
  i=0;
  for(List<String> list : responseHeaders) {
   String msg = "" + list.get(0) + "=" + list.get(1);
   OHLog.warn(903, i++, msg);
  }
  
  if(httpStatusCode>=300) {
   throw new OHException(500, httpStatusCode, "HTTP status code 
["+httpStatusCode+"] too high");
  }
 }

 public void onError(Throwable cause, URL url,
         String requestBody, List<List<String>> requestHeaders) {
  
  if(url != null) {
   OHLog.info(901, 101, url.toString());
  }
  if(requestBody!=null){
   OHLog.debug(902, 102, requestBody);
  }
  int i=0;
  if(requestHeaders != null) {
   for(List<String> list : requestHeaders) {
    String msg = "" + list.get(0) + "=" + list.get(1);
    OHLog.warn(903, i++, msg);
   }
  }
  System.out.println("onError called with following stack trace:");
  cause.printStackTrace();
  System.out.println("^^^^^^");
  throw new OHException(904, 103, "old exception said 
'"+cause.getMessage()+"'");
 }
}
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Obtaining Help and Additional Information

Use the Sybase Getting Started CD, Product Documentation site, and online help to learn
more about this product release.

• The Getting Started CD (or download) – contains release bulletins and installation guides
in PDF format, and may contain other documents or updated information.

• Product Documentation at http://sybooks.sybase.com/ – is an online version of Sybase
documentation that you can access using a standard Web browser. You can browse
documents online, or download them as PDFs. In addition to product documentation, the
Web site also has links to EBFs/Maintenance, Technical Documents, Case Management,
Solved Cases, Community Forums/Newsgroups, and other resources.

• Online help in the product, if available.

To read or print PDF documents, you need Adobe Acrobat Reader, which is available as a free
download from the Adobe Web site.

Note: A more recent release bulletin, with critical product or document information added
after the product release, may be available from the Product Documentation Web site.

Technical Support
Get support for Sybase products.

If your organization has purchased a support contract for this product, then one or more of
your colleagues is designated as an authorized support contact. If you have any questions, or if
you need assistance during the installation process, ask a designated person to contact Sybase
Technical Support or the Sybase subsidiary in your area.

Downloading Sybase EBFs and Maintenance Reports
Get EBFs and maintenance reports from the Sybase Web site or the SAP® Service
Marketplace (SMP). The location you use depends on how you purchased the product.

• If you purchased the product directly from Sybase or from an authorized Sybase
reseller:

a) Point your Web browser to http://www.sybase.com/support.
b) Select Support > EBFs/Maintenance.
c) If prompted, enter your MySybase user name and password.
d) (Optional) Select a filter, a time frame, or both, and click Go.
e) Select a product.
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Padlock icons indicate that you do not have download authorization for certain EBF/
Maintenance releases because you are not registered as an authorized support contact.
If you have not registered, but have valid information provided by your Sybase
representative or through your support contract, click My Account to add the
“Technical Support Contact” role to your MySybase profile.

f) Click the Info icon to display the EBF/Maintenance report, or click the product
description to download the software.

• If you ordered your Sybase product under an SAP contract:

a) Point your browser to http://service.sap.com/swdc and log in if prompted.
b) Select Search for Software Downloads and enter the name of your product. Click

Search.

Sybase Product and Component Certifications
Certification reports verify Sybase product performance on a particular platform.

To find the latest information about certifications:

• For partner product certifications, go to http://www.sybase.com/detail_list?id=9784
• For platform certifications, go to http://certification.sybase.com/ucr/search.do

Creating a MySybase Profile
MySybase is a free service that allows you to create a personalized view of Sybase Web pages.

1. Go to http://www.sybase.com/mysybase.

2. Click Register Now.

Accessibility Features
Accessibility ensures access to electronic information for all users, including those with
disabilities.

Documentation for Sybase products is available in an HTML version that is designed for
accessibility.

Vision impaired users can navigate through the online document with an adaptive technology
such as a screen reader, or view it with a screen enlarger.

Sybase HTML documentation has been tested for compliance with accessibility requirements
of Section 508 of the U.S Rehabilitation Act. Documents that comply with Section 508
generally also meet non-U.S. accessibility guidelines, such as the World Wide Web
Consortium (W3C) guidelines for Web sites.
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Note: You may need to configure your accessibility tool for optimal use. Some screen readers
pronounce text based on its case; for example, they pronounce ALL UPPERCASE TEXT as
initials, and MixedCase Text as words. You might find it helpful to configure your tool to
announce syntax conventions. Consult the documentation for your tool.

For information about how Sybase supports accessibility, see the Sybase Accessibility site: 
http://www.sybase.com/products/accessibility. The site includes links to information about
Section 508 and W3C standards.

You may find additional information about accessibility features in the product
documentation.

Obtaining Help and Additional Information

Release Bulletin for Sybase Mobile SDK 45

http://www.sybase.com/products/accessibility


Obtaining Help and Additional Information

46 Sybase Unwired Platform


	Release Bulletin for Sybase Mobile SDK
	Contents
	Product Summary
	Upgrading and Migrating
	Native Client Object API Version Compatibility Matrix
	Migrating Object API Applications
	Android
	BlackBerry
	iOS
	Windows and Windows Mobile

	Object API Changes from Version 2.1 through Version 2.1 ESD #2
	Object API Changes in SDK Version 2.1 ESD #2
	Object API Changes in SDK Version 2.1


	Hybrid Web Container Version Compatibility Matrix
	Migrating Mobile Workflow Projects

	OData SDK Client Version Compatibility Matrix

	Updates to Supported Operating Systems
	Updates to Certified Devices
	Changed or Deprecated Features
	Known Issues with Installing, Uninstalling, and Upgrading
	Known Issues for Sybase Unwired WorkSpace – Mobile Business Object Development
	Known Issues for Sybase Unwired WorkSpace – Mobile Workflow Package Development
	Known Issues for Native Object API
	Known Issues for Hybrid Web Container
	Known Issues for MAKit
	Documentation Issues and Updates for Mobile SDK
	Editing the Result Checker
	Writing a Custom Result Checker
	Result Checker Logging

	Obtaining Help and Additional Information
	Technical Support
	Downloading Sybase EBFs and Maintenance Reports
	Sybase Product and Component Certifications
	Creating a MySybase Profile
	Accessibility Features



